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Meanings of symbols used

The following table shows the symbols used in this manual, along with descriptions of what they mean.

CAUTION Indicates something that may cause injury or damage to the projector.
@ TIP Indicates information that is related to a topic or which may be useful to know.
C Indicates a page where a related topic or a more detailed explanation is provided. Click on the page
number to display that page.
[ (Name) | Indicates the name of a projector port or a computer menu or item name.

Example: [InputA] [Start]
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Tasks that can be done using EMP Monitor

EMP Monitor lets you carry out operations such as checking the statuses of
multiple EPSON projectors that are connected to a network at a computer
monitor, and controlling the projectors from the computer.

Following are brief descriptions of the monitoring and control functions that
can be carried out using EMP Monitor.

 Registering projectors for monitoring and control

- Projectors on the network can be searched for automatically, and you can

then select projectors to be registered from the projectors that are detected.

- You can enter the IP addresses for target projectors to register them.

 Registered projectors can also be assigned to groups so that they
can be monitored and controlled in groups

« Monitoring the statuses of registered projectors

- The power status (ON/OFF) for projectors and problems or warnings
requiring attention can be checked visually by means of icons.

- You can select groups of projectors or a single projector that you are
interested in, and then check the cumulative lamp operating time or the
details of information such as input sources, problems, and warnings for
these projectors.

« Controlling registered projectors

- Projectors can be selected in groups or as single projectors, and you can
then carry out operations for the selected projectors such as turning the
power on and off and switching their input sources.

- Web control functions can be used to change the settings in the projector's
configuration menu.

- If there are certain control actions which are carried out regularly at
particular times or on particular days, you can use "Timer Settings" to
register timer settings.

« E-mail notification function settings

You can set e-mail addresses to which notifications are sent if a status

requiring attention, such as a problem, occurs with a projector that has been

registered.

| wantto turn on the
power for Group A
prOJectors

-

Projector A

S

Projector B

EMP Monitor

System configuration example

@ TIP

To enable projectors to be monitored and controlled even when they
are in standby mode*, make the following settings at the projectors.
The settings that need to be made will vary depending on the projector
you are using.

@ ""Configuration menus'' in the projector's User's Guide.

e Set '"Network Monitoring'' to ""ON"'.

o Set ""Standby Mode' to '"Network ON''.

* When the projector's () (Power) indicator is lit orange



Operating environment

Compatible computers

Macintosh computers cannot be used.

OS Windows 98 Second Edition SP1/Me/NT.4.0 SP6/2000
Professional SP4/XP 32-bit versions (Home Edition/
Professional) SP1 and later/Vista 32-bit versions (Home
Basic/Home Premium/Ultimate/Business/Enterprise
Editions)
e Internet Explorer Ver. 5.0 or later must be installed.

CPU Pentium MMX 166 MHz or higher (Pentium II 233 MHz
or higher recommended)

Memory 64 MB or more (128 MB or more recommended)

capacity

Free hard disk | 50 MB or more

space

Display SVGA (800x600) or higher resolution, 32 bit or higher

display colour

* Operations carried out at the computer may become slow depending on the
number of projectors being managed. If this happens, use a computer with
higher specifications.

* EMP Monitor cannot be used in environments which do not allow pings to

be transmitted.

Installing EMP Monitor

When you are using Windows2000/NT4.0/XP/Vista, you must have
administrator authority in order to install EMP Monitor.

This application supports the languages listed in @ Languages supported
by the application.

When the language selected for the EMP Monitor installation varies from
that of the OS being used, the EMP Monitor screens may not be displayed

correctly.

1

PROCEDURE

Turn the computer on.

To prevent problems from occurring during the installation, we
recommend that you terminate all resident applications that can
be ended.

Place the "EPSON Projector Software for Meeting &
Presentation" CD-ROM in the computer's CD-ROM
drive.

The installer automatically starts up.

This installer supports the languages listed in @~ Languages
supported by the automatic installer. When using any of these
languages for the installation, go to step 4.

When installing EMP Monitor in another language, click €2 to
close the installer screen, and then perform the following
procedure.

Using Windows Explorer or similar, display the files
available on the CD drive, and then double-click
"Monlinst.exe" in the following location.

(CD drive)\MON\MonlInst.exe

From here, continue with the installation by following
the on-screen messages.



Operating environment

¥ Languages supported by the application Before starting operations
I?HFEE, English, Francais, Deutsch, Italiano, Espafiol, Portugués, Check the following points before starting up EMP Monitor.
Sh= 0, qﬂvi(ﬁﬁ{zk) , P X (%4F), Nederlands, Dansk, Polski, « EMP Monitor must be installed on the computer to be used for
Magyar, Cestina, Romana, Slovenscina, Norsk, Svenska, Suomi, monitoring and control.
Pycckuit, YkpaiHcbka, EAANVIKG, TUrkge , duy=ll * The computer and the projectors must be connected to the network.

e If using Windows 2000, NT4.0, XP, or Vista, the computer must be

Note that Ukrainian is not supported by Windows Vista. ) .
started up in Administrator mode.

Arabic is not supported by Windows NT4.0.

When using EMP-6000/82/62/828/821/81/61
* A commercially-available serial <> TCP/IP conversion adapter and a

English, BAE, Francais, Deutsch, Italiano, Espafiol, Portugués, connection cable are required in order to use EMP Monitor.
th 3 (f€4h) . sH=0f @ "Standby mode" in the projector's User's Guide

* Make the settings for the serial <> TCP/IP conversion adapter before
connecting to the projector.

I Languages supported by the automatic installer

Limitations imposed by a Windows Vista
environment

When using EMP Monitor under Windows Vista, note the following

limitations.

* You must have administrator authority in order to use "Register at
startup” on the "Environment setup" screen of EMP monitor.
@ "Monitoring using the system tray" p.22

* Even after EMP monitor has been uninstalled, the settings and log
information will remain on the hard disk. If this information is no longer
required, you may delete the "EMP Monitor V4.21" folder. Provided the
default settings were used at installation, this folder can be found at:
"C:\Users\(User Name)\AppData\Local\VirtualStore\Program
Files\EPSON Projector\EMP Monitor V4.21"



Registering and deleting projectors for monitoring

This operation is carried out when starting EMP Monitor for the first time after
it has been installed and when you would like to add projectors. Once a
projector has been registered, the status for the projector will be displayed
automatically each time EMP Monitor is started from that point onwards.

Starting EMP Monitor

PROCEDURE

Click [Start] - [Programs] (or [All Programs]) - [EPSON
Projector] - [EMP Monitor V4.21] in that order to start
EMP Monitor.

@ The main window will be displayed.
"Grouping view"

e Y (]

Eile  Edit Miew Tool Help
| Refiesh Select al B¢ = .. e

The operations to register projectors using the automatic search will
vary depending on where the projectors are connected to in the
network.

e When registering a projector that is located in the same segment
that the computer the EMP Monitor is installed in is associated
with. @ "Registering projectors using automatic search (Searching
for and registering projectors that are located in the same segment)"
p-8

e When registering projectors that are in multiple segments of the
network @ "Setting the range of addresses to do an automatic
search and registration" p.10



Registering and deleting projectors for monitoring

Registering projectors using automatic search 2 ) Click [Search].
(Searchl_ng for and registering projectors that are Automatic search will be carried out, and the names of the
located in the same segment) projectors that have been detected will be displayed.

* If a projector does not appear in the list, use "Registration by
specifying an IP address (Manual registration)". @ p.12

P ROC E D U R E Create new projector {aukomatic registration)

Projector name IP address
. Projectar10 192168.040
M Procedures for automatic search Projectar 192168041
Projector1Z 192168042
1 ) Right-click in "Grouping view" and select "New" - et by
“Projector (automatic search)". Projsctorts 102168045
Projectarid 192168.046

The "Create new projector (automatic registration)" window
will be displayed.

* If "Detail list view" is displayed, select "New" - "Projector
(automatic search)" from the "Edit" menu.

[ Specify an address range and search.

Start address End address

Search Edit Cancel
@ TIP

® You can also carry out this operation by selecting ''Projector
(automatic search)' from '"New'' in the ""Edit"’ menu.

® Projectors that are using a serial < TCP/IP conversion adapter
cannot be detected.

Create new projector {automatic registration)

[ Specify an address range and search.

Start address End address

Search Edit Cancel




Registering and deleting projectors for monitoring

M Procedures for registration

3 ) Select the projector(s) to be registered, and then click

[Edit].

The following window will be displayed.
Make the necessary settings while referring to the following

table.

Create new projector (automatic search)

Dizplay name

Display icon

PBaient group

Projector name

IP address

-
Paort Murmber
tonitar Paszword

Diescription

Iv  Monitar

< [ |
|[N ang) j
|Pr0]ect0r1 1]
| 169 . 254 163 . 151 Seaich
—

Reqister Cancel

Display name

Enter the name of the projector(s) to be displayed in
"Grouping view" or "Detail list view".

Up to a maximum of 32 bytes can be entered.

A space cannot be used as the first character.

Display icon

Select the icon(s) to be displayed in "Grouping view"

or "Detail list view".

Parent group

Select when registering a projector in a group.
If no groups have been created, this cannot be
selected. @ "Registering several projectors to a
monitoring group all at once" p.13

Projector This shows the name that has been registered on the
name projector.

IP address This shows the IP address for the registered projector.
Use Serial < | This cannot be selected when registering projectors
TCP/IP using automatic search.

conversion

adaptor.

Port Number

This cannot be selected when registering projectors
using automatic search.

Monitor
Password

If a Monitor Password has been set for the projector,
be sure to enter the Monitor Password that has been
set. If the correct password is not entered at this time,
it will not be possible to monitor and control the
projector even though it is registered.

Description

You can enter some kind of memo about the projector.
The details you enter here will be displayed at the
projector properties.

Up to a maximum of 60 bytes can be entered.

Monitor

Select this when you want monitoring to start.

4 ) After entering the details, click [Register] to start the
registration. When the message is displayed, click

[OK].

To continue registering other projector(s), repeat Steps 3 and 4.

@ TIP

Projectors that have been registered using automatic search are
searched for again by projector name each time EMP Monitor is
started.



Registering and deleting projectors for monitoring

5 ) Toend the registration operation, click the [X] in the
top-right corner of the window or click [Cancel].
The icon(s) of the projector(s) you registered will be displayed
in "Grouping view" or "Detail list view".
Refer to "Monitoring window layout" for details on using the
"Grouping view" and "Detail list view". @ p.17

Setting the range of addresses to do an automatic
search and registration

@ TIP

Projectors that are using a serial < TCP/IP conversion adapter
cannot be detected.

PROCEDURE

M Procedures for automatic search

1 ) Right-click in "Grouping view" and select "New" -
“Projector (automatic search)".
The "Create new projector (automatic registration)" window
will be displayed.

* If "Detail list view" is displayed, select "New" - "Projector
(automatic search)" from the "Edit" menu.

2 )| Select the "Specify an address range and search"
check box and then enter the starting address and
ending address in the range.

! I S’ecwfy an address r. -
Start address 192 . 168 . 0 . 00

nd address

Edit

192 166 . 0

ancel

. 50

o

3 ) Click [Search].

Automatic searching will be carried out, and the names of the
projectors that have been detected will be displayed.

Create new projector {automatic registration)

Projectar name
Projector10
Projectorl
Projector12
Projector13
Projector14
Projector1s
Projector16

v Specify an address range and search,

IP address

192.168.0.40
192.168.0.41
192.168.0.42
192.168.0.43
192.168.0.44
192.168.0.45
192168046

. oo End address

Edit

192 . 168 . 0

Cancel




Registering and deleting projectors for monitoring

M Procedures for registration Projector This shows the name that has been registered on the
. . . name projector.
elect the projector(s) to be registered, and then click
4 [SE dit] proj (s) 9 ’ IP address This shows the IP address for the registered projector.
o . : . Use Serial< | This cannot be selected when registering projectors

The following window will be displayed. TCP/IP using automatic search.
Make the necessary settings while referring to the following conversion
table. adaptor.

Create new projector (automatic search)

Dizplay name

Digplay jcon

Parent group
Frojector name

IP address

-
Port Murmber
onitor Password

Description

|v ' Monitor

| [Mone] j

[Projectorin

| 169 . 284 . 163 . 151 Search

—
|

Port Number

This cannot be selected when registering projectors
using automatic search.

Monitor
Password

If a Monitor Password has been set for the projector,
be sure to enter the Monitor Password that has been
set. If the correct password is not entered at this time,
it will not be possible to monitor and control the
projector even though it is registered.

Description

You can enter some kind of memo about the projector.
The details you enter here will be displayed at the
projector properties.

Up to a maximum of 60 bytes can be entered.

Monitor

Select this when you want monitoring to start.

FRegister

Cancel

After entering the details, click [Register] to start the
registration. When the message is displayed, click

[OK].

To continue registering other projector(s), repeat Steps 4 and 5.

Display name | Enter the name of the projector(s) to be displayed in

"Grouping view" or "Detail list view". 6 )| To end the registration operation, click [X] in the top-

Up to a maximum of 32 bytes can be entered.
A space cannot be used as the first character.

Display icon

Select the icon(s) to be displayed in "Grouping view"
or "Detail list view".

Parent group

Select when registering a projector in a group.
If no groups have been created, this cannot be
selected. @ "Registering several projectors to a
monitoring group all at once" p.13

right corner of the window or click [Cancell].

The icon(s) of the projector(s) you registered will be displayed
in "Grouping view" or "Detail list view".

Refer to "Moitoring window layout" for details on using the
"Grouping view" and "Detail list view". @ p.17



Registering and deleting projectors for monitoring X 12

Registration by specifying an IP address (Manual 2\ Enter the IP address of the projector to be registered
registration) in the "IP address" box and then click [Search]. When
the message is displayed, click [OK].

* If using a serial < TCP/IP conversion adapter and cable to connect

PROCEDURE the projector, select "Use Serial < TCP/IP conversion adaptor".
Enter the port number in "Port Number" and then click [Search].

1 ) Right-click in "Grouping view" and select "New" -
“Projector (manual registration)". 3 ) After searching is complete, enter the information for
The following window will be displayed. the projector to be registered while referring to the

o If "Detail list view" is displayed, select "New" - "Projector (manual table below.

registration)" from the "Edit" menu. - - - -
Display name | Enter the name of the projector(s) to be displayed in

"Grouping view" or "Detail list view".

Create new projector {manual registration)

Hispla rame I Up to a maximum of 32 bytes can be entered.

Dplice . - A space cannot be used as the first character.
& e Display icon | Select the icon(s) to be displayed in "Grouping view"
« | O or "Detail list view".

Prent group [iNone) = Parent group | Select when registering a projector in a group.

If no groups have been created, this cannot be
selected. @ "Registering several projectors to a
17 zdress I Sata monitoring group all at once" p.13

Frojector name |

[ Use Serial <-» TCPAP conversion adaptar.

Projector This shows the name that has been registered on the
Fat Rumber name projector.
Monkor Passpord | IP address This shows the IP address that you entered in step 2.
. Use Serial < | Select this if using a serial <> TCP/IP conversion
- TCP/IP adapter to connect the projector.
. conversion
Beaqister Cancel adaptor
Port Number | If using a serial << TCP/IP conversion adapter to
@ TIP connect the projector, enter the port number.

You can also carry out this operation by selecting ''Projector (manual
registration)'' from ""New'' in the ""Edit'" menu.



Registering and deleting projectors for monitoring X 13

Monitor If a Monitor Password has been set for the projector, RegiStering several ProieCtorS toa monitoring group
Password be sure to enter the Monitor Password that has been all at once
set. If the correct password is not entered at this time,
it will not be possible to monitor and control the Projectors that have been registered can then be registered together into
projector even though it is registered. If using a serial different groups so that they can be monitored and controlled together.
= TCP/ IP Convergion adapter to connect the ) Furthermore, if you select one of the registered groups as the "Parent
projector, the Monitor Password security function group", monitoring and control operations can be carried out for all
cannot be used. projectors in that "Parent group".
Description You can enter some kind of memo about the projector. A "Parent group" can be set for other parent groups, so that a hierarchical
The details you enter here will be displayed at the group arrangement such as the following can be created.
projector properties.
Up to a maximum of 60 bytes can be entered. Branch A —— Showroom Showroom A No1
Monitor Select this when you want monitoring to start. ez
No3
Showroom B —I:No4
4 ) After entering the details, click [Register] to start the | Lobby No5
rgglj(lstratlon. When the message is displayed, click | Convention hall S r
[OKI. |: Projector02
The icon(s) of the projector(s) you registered will be displayed
in "Grouping view" or "Detail list view". Branch B Conference room 18(1)
102
103
Reception room Room 1
L Room 3
Branch C Conference room 201
|— 202

First, create the registration groups, and then register projectors into the
groups that have been created.



Registering and deleting projectors for monitoring X 14

PROCEDURE @ TIP
1 ) Right-click in "Grouping view" and select "New" - You can also carry out this operation by selecting ''Group'' from
"Group". "New''in the "Edit'" menu.

The following window will be displayed.
Make the necessary settings while referring to the table below.

o If "Detail list view" is displayed, select "New" - "Group" from the
"Edit" menu.

2 | After entering the details, click [Register] to start the
registration. When the message is displayed, click
[OK].

The icon(s) of the projector(s) you registered will be displayed
in "Grouping view" or "Detail list view".

Group name | |

Dizplay jcon

‘ R 3 ) Right-click the projector icon(s) to register to the
T—— group you have created in "Grouping view" or "Detail
Cias one = list view", and select "Edit".

-

Register Cancel @ TI P

You can also carry out this operation by selecting ""Edit'" from the
Group name | Enter the name of the group(s) to be displayed in "Edit" menu.

"Grouping view" or "Detail list view".
Up to a maximum of 32 bytes can be entered.

A space cannot be used as the first character. 4 ) Inthe "Edit projector" window, select the group name
Display icon | Select the icon(s) to be displayed in "Grouping view" to use for registering in "Parent group” and then click
or "Detail list view". [Change].
Parent group | This selects the parent group. If no groups have been The status of the group registration will be displayed as an icon
created, this cannot be selected. in "Grouping view" or "Detail list view".
Monitor Select this to monitor all projectors that have been
registered in the group. If this is not selected, the TIP

settings made when the individual projectors were
registered will be used.
It cannot be set when creating a new group.

The registration details can also be checked using ''Projector list'' in
the ""View' menu.




Registering and deleting projectors for monitoring X 15

If the projector name or IP address changes after W For projectors that have been registered using automatic
registration search
PROCEDURE

M For projectors that have been registered manually

1 | Delete the projector(s) whose name or IP address has
PROCEDURE been changed in "Grouping view" or "Detail list
view". @ p.16
1 ) Right-click on a projector icon in "Grouping view" or >
“Detail list view" and select "Monitoring disabled".

Then right-click the projector icon again and select 2 ) Carry out automatic search to re-register the
“"Edit". projector(s). @ p.8

@ TIP

You can also carry out these operations by using the ""Edit"’ menu.

2 ) If only the projector name has been changed, click
[Search] in the "Edit projector" window that is
displayed.

If the IP address has been changed, enter the new IP
address in the "IP address" box and then click
[Search]. When the message is displayed, click [OK].

3 ) When the display returns to the "Edit projector"
window, click [Change].



Registering and deleting projectors for monitoring

Cancelling (deleting) projector registrations

The registrations for projectors can be deleted if they are no longer
required for monitoring or control using EMP Monitor.

| PROCEDURE

Right-click the icon for the projector or group that is to be

deleted in "Grouping view" or "Detail list view" and select

"Delete".

When the message is displayed, click [OK].

More than one projector can be selected for deleting by selecting in

"Grouping view" or "Detail list view".

The methods of selecting more than one projector at the same time are as

follow.

* If you select a group icon in "Grouping view", all projectors that have
been registered in that group will be deleted at the same time.

* Hold down the [Ctrl] key on the keyboard while clicking on the desired
icons.

* Use drag and drop to select a range of desired icons.

TIP

You can also carry out this operation by selecting ''Delete'’ from the
"Edit'" menu.




Monitoring window layout B

You can monitor using either of the window layouts below. Monitoring using "Grouping view"
« "Grouping view"
This view lets you check the status of group registrations in a hierarchical

M Meanings of "Grouping view" icons

diagram.
o "Detail list view" In "Grouping view", the patterns on the icons indicate the statuses of the
This view lets you display the status of each projector as a list so that the projectors.
projectors can be checked in detail. You can also display specific items as a s =
list, and sort display items using a specific row as a sort key. N e Tl
— - . | Reiesh | Sekotal ¢y e oo [mml
VO BE - B=@ K seeta u(‘)kiw“"zcgaj
@ Loy [} P = “G : g "
& @ T = E) ——"Grouping view
- T A © (€
Branch B Branch G &) Nod () 15H [ ] Eranch A Branch B Branch G
@ . 5 ° G —
= e < Sh C \If the group
& Projectort 02 68H oW a0 m onvention obby .
a i < i el icons are round
€ 101 [+) 100H [ — H H
= —— | A () in shape, it
= e ) I B indicates that
® = | .
a = ° ——— there is another
- level below
) : o ) them. @ p.18
"Grouping view" "Detail list view" e %
Mot MNa2 Nod

M How to switch views

"Grouping view" and "Detail list view" are switched as follows.

| PROCEDURE

Click the "View" menu, and select "Grouping view" or
"Detail list view".



Monitoring window layout X 18

The icon patterns and their meanings are explained below. *] When "Temperature level display group view" is set to "On" at

"Environment setup” in the "Tool" menu, an icon indicating the internal
temperature of the projector will be displayed on top of the projector
icon. The default setting is "Off". As you can get an idea of how the
i Warning or problem temperature insid§ thc? projector is increasing yvhen the internal

A projector in the group has a warning or problem temperature level is displayed, you can make improvements to the
status. projector's operating environment before a high internal temperature
alarm occurs or the temperature becomes abnormally hot. @~ p.23

No warnings or problems
All projectors in the group are normal.

Notification . e R
A projector requiring immediate attention has been 2 Check the following items.
detected within the group. * Check that the projector's power is turned on.

. Monitoring disabled * Check that the LAN cable is connected.
The projector is not being monitored. If you right- * Check that "Network Monitoring" is set to "ON" or "Standby Mode"
click the icon and select "Monitoring enabled", the is set to "Network ON" in the projector's configuration menu.
projector will be added to the projectors that are *3 Check that the projector has been correctly connected to the network.
being monitored.

. , @ TIP

L@ Data being updated

The projector information that is generated when a problem is

Projector detected is stored until EMP Monitor is closed. The EMP Monitor

*1

(] No warnings or problems displays will not be updated automatically even if the projector status
_ returns to normal. Click [Refresh] in the main window to update the
Warning or problem status.
Notification
&= Monitoring disabled W Using the icons in "Grouping view"
- Data being updated The following icon operations can be carried out in "Grouping view".
il ) o « Expanding and collapsing icons
@ I;lrer;[)"l\”)ork error (monitor password authentication Each time you double-click a group icon, the icons for the projector that
No Monitor Password was entered when the projector have been registered in that group are displayed or hidden.
was registered, or an incorrect Monitor Password was « Moving icons . ) o ) e
entered. @ p.9, 11, 13 To change the position of an icon within "Grouping view", simply drag
— . and drop the icon to be moved.
e Network error (TCP connection error) 2 P
€A Network error (ESC/VP.net communication
?

f

error) 3
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Monitoring using "Detail list view" Monitoring disabled
The projector is not being monitored. If you right-click
. . L o the icon and select "Monitoring enabled", the projector
™ Meanings of "Detail list view" icons will be added to the projectors that are being monitored.
The status of registered projectors is displayed as a list in "Detail list view" o= Data being updated
regardless of which groups the projectors belong to. _ o
= Network error (monitor password authentication
F Edt Wew Tool Help 7 error)
Ffech oot 8o == = No Monitor Password was entered when the projector
Tm:'ua_ | Graup name | Display nams  ~ | Power ‘ Lamp Haurs ‘ Temperature level Was I‘egistered’ OI‘ an incorrect Monitor Password Was
B | ooans o 9 . — entered. @ p.9, 11, 13
@ Brarch A/Showroom/Showraom & Nol @ 120H (]
B emveemmamn 8 o ! s &9 | Network error (TCP connection error) 2
(5] Branch A/Showroom/Showraom & Mo @ 16H (I ———] =
B G Moo | Mok o o = el Network error (ESC/VP.net communication error) 2
@8  Branch AfShomroom/Shomroom & Mo @ 85H [ !
&5 e Aoventin il Rodesfon @ 200 = Group name: When projectors are registered to a group, the name of
B | S Mol rropeen @ e - the group that the projector belongs to is displayed.
f8)  Branch B/Canfersnce Room 100 @ 49H (——— - -
B | coneesen ) oo — Display name: Shows the display name.
(@5 eranch B/Caerece Room 102 @ B e Power: Shows the power on status for the projector.
[507) Eranch B/Gonterence Room 103 @ 78H [
— Power on and normal Power on and
(@)  Branch B/Reception Room Fioom 1 @ 79H e
B | Bediomiiatomn F— Q@ aon S status abnormal status
g - Power off and normal Power off and

status abnormal status

The icon patterns and their meanings are explained below.

Temperature level: The following five icons display the differing
internal temperature status of the projector.

Type: Displays the projector status.

i 1 Internal temperature High-temperature
e No warnings or problems™ p gh-temp
. W | hormal (- warning
Sy XVarnlnghor problengl h . Internal temperature Internal temperature
n 6.31.’1‘01‘. as occurred on the projector. == hormal error
NOt'flca,t'on .. ) ) High-temperature
The projector requires immediate attention. [T T |

warning
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Error information: Shows a notification or warning/problem status @ TIP

using the following icons.
= Clean Air Filter
Notice

E Replace Lamp ™ displays will not be updated automatically even if the projector status
_ _ returns to normal. Click [Refresh] in the main window to update the
E High-temperature |_r - Lamp failure at ]
warning L 2 power on

The projector information that is generated when a problem is

L C O
amp Lover Lpen detected is stored until EMP Monitor is closed. The EMP Monitor

\Li
Fl Lamp Error

Replace Air Filter

H. h . t 1 . . H
) 1gh interna W Selecting display items

temperature error

= No Air Filter Internal Error You can select only the required items to be displayed in "Detail list view".
EA | Low Air Flow = Fan error

: ""] PROCEDURE

= Air Flow Sensor Err. l{‘ﬂ Sensor error

1 ) Select "Option" from the "View" menu.
The "Option" window will be displayed.

Other error

Air filter air flow
SeNsor error

£S5
=%
Low air flow error

*1 When "Temperature level display group view" is set to "On" at
"Environment setup” in the "Tool" menu, an icon indicating the internal
temperature of the projector will be displayed on top of the projector
icon. The default setting is "Off".

*2 Check the following items.

* Check that the projector's power is turned on.

* Check that the LAN cable is connected.

* Check that "Network Monitoring" is set to "ON" or "Standby Mode"
is set to "Network ON" in the projector's configuration menu.

*3 Check that the projector has been correctly connected to the network.

*4 You can display the "Replace Lamp" warning at any time preset in
"Environment setup" in the "Tool" menu.

Display items

vy

v Group name

[ Projector name:
v Display name

[ IP address

v Prwuer

v Lamp Hours

[~ Source

v Temperature level
[ Description

[ Errar infarmation

Ok

Cancel
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2 ) Select the check box of the item you want to display.
3 ) Click [OK].

4 ) When all of the details of the item cannot be displayed
in "Detail list view", drag the boundary line on the

right of the item name so that the view is extended to
the desired width.

M Sorting lists

You can sort detailed lists by using a specific row as a sort key, such as
projector name order or IP address order.

PROCEDURE

Click the item name of the row you want to use as the sort
key.

Searching for desired icons (Projector list)

The "Projector list" feature is useful for searching in lists when many

groups and projectors are registered and the icon you are looking for is not
displayed on screen.

PROCEDURE

Select "Projector list" from the "View" menu.

Corwvention Hall

&3 Lobby

= Showroom
= Showroor &
) Mol
o With "Projector list", t t
e ) [T I _ J Ist”, .empera ure
% (5) Showroom B level icons are not displayed
4 (&3 Branch B regardless of the setting of
I (@ Branch C "Temperature level display group
view" at "Environment setup".

The "Projector list" lets you check the registration details for groups in a
hierarchical diagram. When you click on an icon, "Grouping view" and

"Detail list view" are scrolled so that the selected icon is displayed in the
window.
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Monitoring using the system tray PROCEDURE

The projector statuses are always displayed as icons in the system tray, 1) Select "Environment setup" from the "Tool" menu.
even when "Grouping view" or "Detail list view" is not always displayed,

and the statuses can be checked by the icon patterns. The "Environment setup” window will be displayed.
When the configuration menus are set using the following operations, an
icon appears in the system tray and the status can be monitored by means

of the icon's pattern. 2 ) Select "Resident in the task tray".

Environment setup

Update interval g 3 mirutes

Temperature level display aroup view ~ 0ff " On

Lamp schedule natification + 0 " On ’? Time
Log output ~ Off  On

[™ Register at startup

[ Change the application lock password

0ld pagsword |

Hew passward |

@ . NO problem Mew passward [confirm) |
& : Problem 0K Cancel

3 Click [OK].

@ TIP

® Right-click the icon in the system tray to open a pop-up menu to
select the '"Open the main screen'' or ""Exit'".

e If ""Register at start up'' in the '"Environment set up'' is selected,
EMP Monitor starts automatically when the computer's power is
turned on. When using EMP Monitor under Windows Vista, you
must have administrator authority in order to use this function.
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The icon patterns and their meanings are explained below.

Displaying projectors with problem or warning

statuses in a list Type: Shows the group or projector status. @ p.17

You can display a list of only the projectors which have a problem or Display name: Shows the display name.

warning status.

Power: Shows the power on status for the projector.

Power on and
abnormal status

Power on and normal
status

| PROCEDURE

Power off and
abnormal status

Power off and normal

Select "Warning and Error Projector list" from the "View" status

menu.
The following "Warning and Error Projector list" window will be
displayed.
A Computer or .
If you move the TR T Video
mouse pointer over mﬂ Computerl
‘wharning and Error Projector list . A
the icon, details of DVI or HDMI
Refresh Select all (I) (I_) Eg EE Bl @ (== the error and the 5“@ COl’l’lputGI’2 (Di ita_])
Display name Pgl Lamp Hours SESCZ_a Temperature \Evenfurmaliun remedy W|" be g
A I L displayed. Ry
T I e i 10QOC | BNC D-Video
No& (IR O™ R — )
I—— If you double-click in I S-Video EasyMP

a line, the properties

for that projector wil Temperature level: The following five icons display the differing

internal temperature status of the projector.

normal

High-temperature
warning

be displayed.
‘ 2| @ p25 Internal temper: High-
perature ] ig .temperature
normal warning
Internal temperature ] Internal temperature

€rror
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Error information: Shows the warning or problem status using the

following icons.

E Replace Lamp*

High-temperature
@ warning

@ Replace Air Filter

!’ No Air Filter

" Low Air Flow

55-:6‘ Air Flow Sensor Err.
Low air flow error

Air filter air flow
SeNsor error

@ &

=
'q d

5 e =

=D
g ]

Lamp Cover Open

Lamp Error

Lamp failure at
power on

High internal
temperature error

Internal Error
Fan error

Sensor error

Other error

*You can display the "Replace Lamp" warning at any time preset in

"Environment setup" in the "Tool" menu.

Checking properties in detail

You can check the properties of groups and projectors in detail.

W Displaying group properties

You can use either of the following methods to display the properties.

* Displaying the properties for all groups in "Grouping view"
Right-click in "Grouping view" and then select "Property".

* Displaying properties for specified groups
Right-click an icon in "Grouping view" and then select "Property".

dades de

i Adualiear

grupo (BranchA)

Seleccionar tudo

0o

R R

E_ Showroom

@ Showroom
(@) Lobby

18H

Tipo | Apresent.. | Fontede ali..  Horazdefu.. | Fonte

Mivel de temperatura | Informagio de emos

If you double-click
in a line, the
properties for that
group or projector
will be displayed.
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M Displaying projector properties Displaying and deleting logs

Right-click on a projector icon in "Grouping view" or "Detail list view"
and select "Property".

In your web browser, you can check a transmission log of content such as
what has been controlled by the EMP Monitor, projector errors. You can
delete logs once you have checked them.

@ TIP
Group name Showroom &

Projector name EMP248214 o o o
' When ''Log output'' is set to ''On'' at ""Environment setup'' in the

Dizplap name Mol

Eftes RTIE ""Tool"" menu, transmission logs are stored. The default setting is
Lamp Hours 38H ”Off’ '.
Temperature level [ =
Description
Ve EmEIER F1 4o001200000/103 ] Displays the | Dlsplaylng |Ogs
projector firmware
Enrernfermation version. PROCEDURE

Select "Log" - "show" from the "View" menu.

The web browser will open and the communication logs up until that
time will be displayed.

W Deleting logs
PROCEDURE

Select "Log" - "Delete" from the "View" menu.
When the confirmation message is displayed, click [OK].

All logs will be deleted and details of EMP Monitor control
operations and details of projector errors from that point onward will
be recorded in a new log.



Using the control functions

Carrying out control using control buttons

Click the icon of a projector to be controlled in "Grouping view" or "Detail
list view", and click a control button to enable control of only that selected
projector.

You can also enable control of all selected projectors by selecting more

than one projector in "Grouping view" or "Detail list view" and clicking a

control button. The methods of selecting more than one projector at the

same time are as follow.

* If you select a group icon in "Grouping view", all projectors that have
been registered in that group and that are set to be monitored can be
controlled at the same time.

* Hold down the [Ctrl] key on the keyboard while clicking on the desired
icons.

* Use drag and drop to select a range of desired icons.

Tool  Help
[ et T [o e = }—Control buttons

Branch B Branch G

=n SWwitch source
*“2 Computer 1

Switches the input source to the [Computer]] port
or [Computer] port.

s Switch source
*® Computer 2

Switches the input source to the [Computer2] port.

ooo S\II\IVECh source Switches the input source to the [BNC] port.
=) Switch source Switches the input source to the [S-Video] port
S-Video p port.
Switch source ) . .
= . Switches the input source to the [Video] port.
Video
Switch source | Switches the input source to the [DVI] port or
= DVI, HDMI [HDMI] port.
Switch source . .
D-Video Switches the input source to the [D4] port.
Switch source Switches to EasyMP or EasyMP.net
EasyMP y yMEnet.

@ TIP

e Some connected projectors may not be equipped with all of the
above ports or functions. If you click a button for a port or function
that is not available, nothing will happen.

® You can select objects to be controlled and use the control buttons to
carry out control operations even when the following are being

The following table shows the meanings of the control buttons.

& Power On

Turns the projector power on.

& Power Off

Turns the projector power off.

displayed. @& For details on each display p.23, 24

- Group properties

- Projector properties

- Warning and Error Projector list (Control operations can only be
carried out for projectors with a warning status.)
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Carrying out control using a web browser (Web Carrying out control using timer settings
control)

This is useful for carrying out certain control operations such as turning a
projector's power on and off at specified times every day or every week.
Timer settings can be carried out either for a single projector only, or all at
once for all projectors in a group.

You can use the computer's web browser to change the configuration menu
settings for projectors.

PROCEDURE
PROCEDURE
1 ) Right-click on the icon of a projector to be controlled
in "Grouping view" or "Detail list view" and select 1 ) Select "Timer" - "Timer Settings" from the "Tool"
“Web control”. menu.

The following window will be displayed and you can then

2\ The web browser will open and the Web control check the timer setting status.

window will be displayed.

W - ﬂ (18/2005 ﬁ
Web control lets you set the same details as the configuration menu for the m el Tz feld T
. . 0 . 12, Showroom A 7 8 El 0 1 1z | 13
projector. Refer to the Projector's User's Guide for details on the am tes LI T LR
configuration menu. s i oo e E s
= [B3 Branch B
@ [ BranchC

Date Time | Operation
2005/08/18 1903 PCZor Input B
2005/08/18 19:06  Power ON
2005/08/18 20:05  Power ON
2005/05/18 20:07  Power ON

@ TIP

(w0t (Poweron |
You can select projectors and right-click on them to select ''Web
control'' even when the following are being displayed. S——— - - —
¢ Group properties @& p.24 fose
. j Error Projector list trol ti l
U (2 oty et W (i) et sy Gt oty e The colours in the lines of the list have the following meanings:

carried out for projectors with a warning status.) @& p.23 [ | Clument days imer seiting

[ ]:When some of the projectors in the group have timer setting
enabled and others have it disabled for the current day's timer
setting

[ 1:When the current day's timer setting is a disabled setting

[

: Timer setting for a day other than the current day
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The details that can be checked and operations that can be carried out at this
time are given below.

Selects a group or projector to check the status of.

Projectors When a group is selected, the timer setting statuses for
all projectors in that group are displayed.
Shows the current day in a red box.
Days for which timer settings have been made are shown
Date in bold.
Click _¢| or | to switch to the calendar for the
previous or next month.
Timers Shows a list of the timer settings.
[Enabled] Switches the timer settings that have been selected from
[Disabled] the timer list between enabled and disabled.
[Add] Registers new timer settings.
Lets you change the timer settings that have been
[Edit] selected from the timer list.
If a group has been selected for status checking, the
settings cannot be changed.
[Delete] Lets you delete timer settings that have been selected

from the timer list.

W Procedures for new timer settings

2 ) When you click "Add", the following window is

3

displayed and the new timer settings are applied.

Create Mew Timer

Schedule mode

-
Date ,W‘
Tirne: ,19297_
Operation ,W‘

0K Cancel

At "Operation", you can carry out the operations of turning the
power on and off and switching the input sources, similarly for
the control buttons on the main window. If you set the input
source switching, the projector's power will turn on at the timer
start time even if it is not on at the time. Because of this, it is not
necessary to make two separate timer settings for turning the
power on and switching the input source.

After completing the timer settings, click [OK].

The timer settings that have been made will be registered and
they can be checked in the displayed timer list.

@ TIP

You can enable and disable all of the timer settings that have been
registered. Select ''Timer'' - ""Enable'’ or "'Disable'’ from the '""Tool"’

menu.



Setting the mail notification function i)

The mail notification function can be used to send corresponding notification 2 ) The "Set mail notification function" window will be
messages to a preset e-mail address when a projector that is connected to the displayed.
network assumes a certain status, or if it experiences a problem or warning. By

) . : a ) Set the following parameters.
using this function, the operator can be notified of a projector's status or

problems even when the operator is in a different location from the projectors. et mai notficstion function
Mail notification function o DN " OFF
@ TIP
® Up to three addressees (destinations) can be registered and SMTP server P addess Port Nuber e

messages can be sent to all of them at once.

¢ If a critical problem develops with a projector which causes it to
suddenly stop working, it may not be possible for the projector to
send a message notifying an operator of the problem.

Sender mail address

Motification ewvent

Fecipient mail address 1 | Motification vent
Fiecipient mail address 2 |

e If "Standby Mode"' is set to ""Network ON'' or ""Network fsspEn el s 2 Hotfsten even
Monitoring'' is set to ""ON'" in the projector configuration menus, oK Cancel
you can monitor the projector even when it is in standby mode
(when its power is turned off). @& Projector's User's Guide Mail notification | Set to "ON" to use the mail notification function.
® On some projectors, the mail notification function can be set in the function
configuration menu. When notification messages are set to be sent SMTP server Enter the IP address of the SMTP server.
in the projector’s configuration menu, both the settings in the IP address Up to a maximum of 255 bytes can be entered.
configuration menu and settings made on EMP Monitor are
Junctional. When you change a port number of the SMTP
server, specify this port number. The default value
is "25".
You can enter a valid number from 1 to 65535.
PROCEDURE Sender malil Enter the sender's e-mail address. Up to a
address maximum of 255 bytes can be entered.
1 ) Select "Mail notification function" from the "Tool" Recipient
R mail address 1
Recipient Spepify Fhe destir_lation addresses fqr th;
mail address 2 notification e-me}ll. Up to three destinations can be
set. Up to a maximum of 255 bytes can be entered.
Recipient
mail address 3
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Click [Notification event] and check the items for mail
notification in the window that appears.

Set mail notification event{Redpient mail address 1)

Set nobification event

Lamp =
v Lamnp failure at powver on
v Lamp Cover Open
W Lamp Ermrar

W Replace Lamp

Air Filker
Iv Clean Air Filter Matice
v Replace Air Filter
W Mo i Filker
I Lowe Air Flaw L
v Air Flow Senzar Er.
¥ Low air flowe errar

W i filter air How sensor erar

Metwork
[ Metwork eror [TCP connection emar)

[ Metwork erar [ESCA/P.net communication emror)

[ Metwork emor [monitar password authentication erar) "

QK Cancel

Click [OK].
When the "Set mail notification function" window appears
again, repeat Steps 3 and 4 to set the events to be notified.

@ When the setup is complete, click [OK].



An e-mail notifying the operator of a problem/warning/status is issued Ty o

If the projector experiences a problem or enters a status requiring attention,
an e-mail like that shown below is sent to the address specified for

"Recipient mail address".

High-temperature

"Reading the indicators"

k . ) . (‘H b b (LI b \
If there is more than one problem, warning, or status, the corresponding wariing Useieg(itlirfethe Indicators” in the projector’s
messages are output to separate lines. Replace Lamp
ltem Details shown Replace Air Filter
E-mail subject [Display name displayed in "Grouping view" or No Air Filter
"Detail list view"] Projector status notification -
Low Air Flow

Body <Display name displayed in "Grouping view"

or "Detail list view"> has entered the following
status.

<Problem/warning/status message (Please see
the table below)>

The details contained in the e-mail message can consist of the following.

Message Remedy

Internal Error

Fan error

Sensor error

Lamp Cover Open

Lamp failure at power on

Lamp Error

High internal
temperature error

Low air flow error

Air filter air flow sensor
error

"Reading the indicators"
@ "Reading the Indicators" in the projector's
User's Guide

Air Flow Sensor Err.

Clean Air Filter Notice

No signal

No image signals are being received by the
projector. Check the connection status and
check that the power for the connected
equipment is turned on.

Other error

Stop using the projector, disconnect the
power cable from the electrical outlet, and
contact your local dealer or the nearest
address provided in the World-Wide Warranty
Terms supplied with the projector.

Network error (TCP
connection error)

Check that the projector's power is turned on
and the LAN cable is connected, and also
check that "Network Monitoring" is set to
"ON" and "Standby Mode" is set to "Network
ON".

Network error (ESC/
VP.net communication
error)

Check that the projector has been correctly
connected to the network.

Network error (monitor
password authentication
error)

Check the projector's Monitor Password.

Messages to inform that the projector has recovered from the error or

warning statuses are sent.



Application lock function

You can use the application lock to prevent third parties from operating the
projectors using EMP Monitor and from changing settings without authority.
Opening and closing EMP Monitor and status monitoring can still be carried
out even when the application lock is applied.

In addition, when a password has been set, the password must be entered in
order to cancel the application lock. This ensures that the application lock can
not be easily cancelled, and thus improves system security.

Switching application lock between enabled and
disabled

M Enabling the lock

PROCEDURE

Select "Application lock" from the "Tool" menu.
The application lock will be enabled and no operations will be

possible other than opening and closing EMP Monitor and disabling
the application lock.
¥ Disabling the lock
PROCEDURE

1 ) Select "Application unlock" from the "Tool" menu.

2 ) The password entry window will be displayed, so
enter the set password and then click [OK].

If no password has been set (default setting), click [OK]
without entering a password. It is recommended that you enter a
password in order to strengthen security.

The application lock will be cancelled and operations can be
carried out as normal.

Setting a password for cancelling application lock

Carry out the following operations while application lock is cancelled.

PROCEDURE

1 ) Select "Environment setup" from the "Tool" menu.
The "Environment setup" window will be displayed.

2 | Select "Change the application lock password".

3 ) Enter the password in both the "New password" and
“New password (confirm)" boxes and then click [OK].

The password can be up to 16 bytes in length. Single-byte
alphanumeric characters can be used.



Troubleshooting o o

Projectors cannot be monitored or controlled

Cause Remedy

An e-mail message is not sent when a problem
occurs with a projector

Is the projector connected to
the network correctly?

Connect the network cable correctly.
@™ "Network Cable Connections" in the
projector's User's Guide

Has the projector been set
up correctly for connection
to the network?

Check the settings for the "Network"
configuration menu command.
@ Projector's User's Guide

Has EMP Monitor been
installed on the computer
correctly?

Uninstall EMP Monitor and then re-install
it.

Are all the projectors that
you want to control or
monitor registered?

Register the projectors. @ p.7

Is the projector's "Network
Monitoring" or "Standby
Mode" configuration menu
set to "ON" or "Network
ON"?

In order to use EMP Monitor to monitor
and control the projector when it is in
standby mode, the projector's "Network
Monitoring" or "Standby Mode"
configuration menu must be set to "ON" or
"Network ON".

@ Projector's User's Guide

Cause Remedy

Is the projector connected to
the network correctly?

Connect the network cable correctly.
@ "Network Cable Connections" in the
projector's User's Guide

Has the projector been set
up correctly for connection
to the network?

Check the settings for the "Network"
configuration menu command.
@ Projector's User's Guide

Have the SMTP server IP
address, port number and
recipient e-mail address all
been set correctly?

Check the setting details.

Is the projector's "Network
Monitoring" or "Standby
Mode" configuration menu
set to "ON" or "Network
ON"?

To use the mail notification function while
the projector is in standby mode, set
"Network Monitoring" or "Standby Mode"
to "ON" or "Network ON" in the
projector's configuration menus.

@ Projector's User's Guide

Has a critical problem
developed causing the
projector to momentarily
stop working?

When the projector has momentarily
stopped working, it cannot send e-mail
messages. If the projector cannot be reset
even after it has been checked, contact your
dealer or the nearest address provided in
the World-Wide Warranty Terms supplied
with the projector.

Is power being supplied to
the projector?

Check if the power supply to the location
where the projector is set up has been
interrupted, or if the circuit breaker for the
electrical outlet that the projector is
connected to has been tripped.
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